
2 
The Batch Pilot Window 

The Batch Pilot Window is the site of your Task Project development and testing 
activities – and is the workshop you’ll use to assemble, modify and script forms that 
becomes a task’s setup and runtime dialogs. 

In addition: 

• Batch Pilot’s Task Setup role allows administrators to define the tasks that are 
part of a Taskmaster workflow. 

• Its Operations role tracks the progress of tasks developed inside the Batch Pilot   
workshop, and provides authorized Data Entry operators with immediate access 
to the images and information a batch contains.  

• Tools of the Batch Pilot Window assemble and manage powerful utilities such as 
Rule Manager and its Rule Manager Window, and the Document Hierarchy 
Setup window. 

Chapter 2 examines the elements of the Batch Pilot Window in various modes as it 
covers these topics:  

I. Introduction ............................................................................................................. 2-3 
A. Task Projects .................................................................................................... 2-5 

II. Structure of the Batch Pilot Window..................................................................... 2-8 

III. Menus of the Batch Pilot Window ....................................................................... 2-10 
A. File Menu .........................................................................................................2-10 
B. Edit Menu.........................................................................................................2-14 
C. View Menu .......................................................................................................2-15 
D. Form Menu ......................................................................................................2-18 
E. Layout Menu.................................................................................................... 2-20 
F. Script Menu .....................................................................................................2-23 
G. Navigate Menu ................................................................................................ 2-25 
H. Help Menu........................................................................................................2-25 

IV. Toolbars of the Batch Pilot Window ................................................................... 2-26 
A. Form Development and Task Project Toolbars........................................... 2-26 

i. Main Toolbar................................................................................................ 2-27 
ii. Form Toolbar ............................................................................................... 2-28 
iii. Layout Toolbar............................................................................................. 2-29 
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iv. Script Toolbar .............................................................................................. 2-31 
B. Task Setup Toolbar ........................................................................................ 2-33 
C. Operations Toolbar ........................................................................................ 2-35 

V. Scripting Aids of the Batch Pilot Window .......................................................... 2-36 
 

 
Batch Pilot Window 

Invoice Application: Data Entry Panel 
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Chapter 2: The Batch Pilot Window 

Introduction 
Snapshots of the Batch Pilot Window are below and on the next few pages.  

Here’s how the window looks the moment you access Batch Pilot using the Programs 
options of your Windows Start button or by double-clicking on a Batch Pilot shortcut 
you’ve placed on your Windows desktop (Chapter 1 describes both approaches.) 

   

Form Design 
mode 

Batch Pilot Window – Form Design Mode 

In the example above, the Batch Pilot Window opens with a “clean” Datacap form 
(.dcf). At this very early stage, the form lacks controls, scripts, even an identity. 
However, there is a Development Toolbox filled with drag-and-drop controls. You can 
use this toolbox and its full array of procedures to design, assemble and test a form 
without delay (Chapter 3). 

9 Note, too, that the window’s default Main toolbar has only a few standard Windows 
icons. For more variety, select Form from the View menu’s Toolbar items – and move 
the Form toolbar up next to the Main toolbar. 

Click here. 
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Task Projects and Task Definitions 

Now, if you un-toggle the Design icon, the window will go into Form Test mode as the 
dotted background gives way to a flat background: 

 

Click here for 
scripting 

Batch Pilot Window – Form Test Mode 

If you click on the Scripting icon, Batch Pilot moves into the Scripting mode that 
developers use to prepare and test a form’s code. 

   
Batch Pilot Window – Form Scripting Mode  

9 The examples above show how the Batch Pilot Window functions as a standalone 
development workshop.  

However, the Batch Pilot Window also serves the Taskmaster side of your Datacap 
Taskmaster configuration as it puts together an application’s Task Projects; assigns 
forms to each project (Chapter 3); participates in the later stages of Task Definition; and 
supplies the User Interface for a task when it runs (Chapter 4). 

9 Important! The 1040EZ training application is the source of most examples and 
illustrations in this chapter and throughout the text. To open this nearly indestructible 
application: 

1. Be sure that your Taskmaster Server Service is up and running. 

2. Select Datacap Taskmaster from your Windows Start button’s Programs options. 

3. Open the Applications folder. 

4. Open the 1040EZ sub-folder: double-click on 1040EZ Client. 

5. Enter your Security codes in the Please Login dialog.   
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Chapter 2: The Batch Pilot Window 

Task Projects and Task Definitions 
A Task Project is the foundation for the setup and runtime components of a task such as 
the 1040EZ application’s Export task. The Export Task Definition designates the 
applicable Task Project. 

A Task Project is a file (.bpp). In this case, the file’s name is RRExport.bpp, and 
you’ll find it in the 1040EZ application’s Process directory.  

For a first look at the 1040EZ Export Task Project, take these steps: 

Step Action 

1. Open Batch Pilot (Page 3) and the Batch Pilot Window. 

2. Select Open Project from the Batch Pilot Window’s File menu. 

3. Use the tools of the Open File dialog to access the Datacap/1040EZ/Process 
folder and to open the RRExport.bpp Task Project file. 

4. Un-select Design from the window’s Form file for a clearer look at the 
project and its setup form within the window.  

 
                             Batch Pilot Window – RRExport Task Project 

9 Chapter 4 shows you how to use the Batch Pilot Window to assemble a Task Project 
(.bpp). 
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Task Projects and Task Definitions 

A different sort of Batch Pilot Window appears when an Export task that employs this 
Task Project is actually defined as a member of a Taskmaster job. To trace this sequence: 

Step Action 

1. Open the 1040EZ Taskmaster Client (Page 4). 

2. Select Workflow from the Settings menu of the Taskmaster Window: the 
Taskmaster Administrator’s Workflow tab will appear on your screen  

 

3. In the Components list on the left, highlight the Main job’s Export task – and 
press the Setup button on the right.  

 

Highlight this 
              task Click here. 

4. When the Setup dialog for the Export Task Definition appears inside the 
Batch Pilot Window (illustrated on the next page), study the settings in its 
principal fields. 
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Chapter 2: The Batch Pilot Window 

 
1040EZ – Export Task Definition 

 Here, the application’s Administrator uses the Batch Pilot Window to assign previously 
defined rules to the task – to the 1040EZ Export task, in this case. (Chapter 4 introduces 
the Task Definition process; Chapter 6 of the Guide to Taskmaster Rules reviews all 
aspects of Task Definition.) 

 Take a moment to compare the illustration of the Batch Pilot Window above to the 
example on Page 5. Note the differences in menu listings, and in the lower portion of the 
windows’ structures. The format and content of the Batch Pilot Window changes in 
response to its role: upcoming descriptions of the window take these changes into 
account. 
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Task Projects and Task Definitions 

Structure of the Batch Pilot Window 
The Batch Pilot Window’s basic design is not unusual. 

There is a Title Bar is at the top, with formatting options in the upper right-hand 
corner (Minimize, Maximize and Close.) The Title Bar identifies the current form 
(.dcf), Task Project (.bpp) or task (when Batch Pilot is in an operating mode.) 

Menus and toolbars line up just below the Title Bar. Alert! The list of menus and the 
availability of toolbars change according to Batch Pilot’s mode.   

The Data Area is home to a form’s design and development procedures, and to task 
setup and runtime dialogs. 

The Status Bar at the bottom specifies the window’s current activity (Form Design 
or Test, for example) and its status (Ready and Start Script Editor are examples.) 
Often, the Status Bar contains supporting information such as your cursor’s location 
within a script. 

Two facets, however, distinguish the Batch Pilot Window: 

• The Batch View area in the window’s lower left-hand corner lists the contents of 
the current batch when a task is running. In the representation of a Verify task’s 
Data Entry Panel on the next page, this area shows a batch with two documents, 
and each document has one page.      
 
Because a Task Project uses Datacap forms (.dcf) as design foundations (see the 
previous section), the project requires links to individual setup and runtime 
forms. When you are assembling a Task Project (Chapter 4), the Batch View 
area contains a Setup Tree with three nodes.  SetupForm at the top designates a 
Task Project’s setup form. The application’s Document Hierarchy is immediately 
below. Usually – but not always! – the runtime form of a ask Project is bound to 
the Document Hierarchy’s Batch object – 1040EZ, in the illustration. A 
RollbackForm node is at the bottom of the tree; a form assigned to this (rarely 
used!) node appears on an operator’s screen when a task based on the Task 
Project rolls back a batch. 

 

          Batch 
             View   
              area 

Setup form

Runtime form
     Document 
      Hierarchy 
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Chapter 2: The Batch Pilot Window 

• Images of source pages play an important role in certain tasks and in 
configuration tools such as the Rule Manager Window. The Batch Pilot 
Window’s Image View area displays images at various magnifications, and 
offers developers and users a complete set of Image Management implements. 
 

 

Image 
View area 

1040EZ Data Entry Panel 

  

 
1040EZ Data Entry Panel – Batch View area 

Both the Batch View area and the Image View area are instantly accessible if you click 
on the Setup Tree and Image View items, respectively, in the File menu. 
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File Menu 

Menus of the Batch Pilot Window 
The tables below and on the next few pages describe all items of the Batch Pilot 
Window’s standard menus. Alert! Special-purpose menus (such as Navigation) appear 
only when the window is in a particular mode such as Operations. In addition, an item 
within a menu may be “grayed out” if the window’s mode does not require it. 

File Menu 
Although this standard Windows menu is a mainstay of the Batch Pilot Window in all its 
modes, the availability of individual items changes according to mode.   

Item Keyboard BP Mode(s) Comment 

New Form Ctrl + N Form 
Development 

Places a blank Datacap form in the 
window’s Data Area, along with the 
Development Toolbox (Page 29). 

A Datacap form is the foundation of a 
Batch Pilot window or dialog.  

A Datacap form is also a file (dcf). 

Open Form… Ctrl + O Form 
Development and 
Testing 

Retrieves an existing Datacap form 
and displays it in the Batch Pilot 
Window, in Design mode. 

Remember! For a clear look at a form 
in the window, un-select the Design 
item in the Form menu. 

Save Form Ctrl + S Form 
Development and 
Testing 

Saves changes to the Datacap form 
(.dcf) you’re working on. 

Many Datacap forms are stock forms: 
they can be assigned to Task Projects 
of any application, and their files 
(.dcf) are usually in a folder of the 
Datacap directory’s BPilot sub-
directory (Chapter 3). 

However, some forms – those of a 
Verification task , for example – are 
application-specific. Their files are 
usually in the application’s Process 
directory.  
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 File Menu (continued)  

Item Keyboard BP Mode(s) Comment 

Save Form 
as… 

 Form 
Development 

Duplicates all attributes of the current 
form except its name, and stores the 
form as a file (.dcf) in a directory and 
folder you specify. 

This option can save you considerable 
time and effort if you use it cautiously.  

New 
Project… 

Ctrl + Alt + 
N 

Task Project 
Setup 

Initiates the steps that define a Task 
Project (Chapter 4), and generate a 
Project file (.bpp). 

Very important! When you select this 
item, Batch Pilot asks you to identify 
the file containing the application’s 
Document Hierarchy (see the example 
below, and Chapter 4.) 

Open 
Project…  

Ctrl + Alt + 
O 

Task Project 
Setup 

Opens an existing Task Project. 

Important! In most cases, a Datacap 
form is a Batch Pilot entity and its file 
(.dcf) is in a folder of the Batch Pilot 
directory. However, a Task Project that 
uses the form belongs to a particular 
application (even if it is a test 
application).  

As a result, Task Project files (.bpp) are  
usually in the application’s Process 
directory. 

 

 

Document 
Hierarchy file 
(.xml) 

           New Project – Document Hierarchy  
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File Menu 

    File Menu (continued)  

Item Keyboard BP Mode(s) Comment 

Save 
Project … 

Ctrl + Alt + S Task Project Setup Saves the settings of a new Task 
Project and places its file (.bpp) in a 
directory you specify, or updates the 
settings of an existing project that’s 
currently open in the Batch Pilot 
Window. 

Remember: a Task Project belongs 
to an application, and its file is 
usually stored in an application’s 
Process directory.  

Save Project 
as… 

 Task Project Setup Duplicates all attributes of the 
current project except its name, and 
stores the new Project file (.bpp) in 
the directory you specify – typically,  
in the application’s Process 
directory. 

Print… Ctrl + P Form Development 
and Testing 

Prints scripts and logs. 

Print Preview  Form Development 
and Testing 

Previews selected pages of a script or 
log. 

Print Setup…  Form Development 
and Testing 

Lists available printers. 

Task 
Settings… 

Ctrl + T Task Project Setup Accesses a Task Project’s Task 
Settings dialog (Chapter 4 and Batch 
Pilot Help.). 

The tabs of this dialog contain 
important settings and parameters 
Taskmaster uses when the Batch 
Pilot project becomes a Taskmaster 
task. 

Test Setup Ctrl  + R Test Setup Checks the accuracy and 
completeness of a Task Project’s 
setup specifications (Chapter 4). 
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File Menu (continued) 

Item Keyboard BP Mode(s) Comment 

Simulate Task Ctrl  + M Test Operations Checks links between the Task 
Project’s Document Hierarchy and its 
runtime form, then tests the project’s 
ability to run a task within the 
Taskmaster environment. 

Important! When you select this 
option, Batch Pilot may ask you to 
identify a Page file (.xml) that was 
generated by the task preceding this 
task in the Taskmaster workflow. If 
you were testing the runtime form of 
an Export Task Project, for example, 
you would probably choose a 
verify.xml file from a test batch. 

Chapter 4 shows you how to use 
Batch Pilot’s Task Simulator feature. 

Quit Task Ctrl  + Q Task Operations After a proper warning, stops a task, 
and places the batch on a Hold status. 

Recent Forms n/a Form Development 
and Task Project 
Setup 

Provides access to Datacap forms 
(.dcf) you’ve worked with recently. 

Recent Projects n/a Form Definition 
and Task Project 
Setup 

Provides access to Task Projects 
(.bpp) you’ve worked with recently. 
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Edit Menu 

Edit Menu 
Although these standard Windows editing procedures are generally available in each 
mode, the circumstances under which you can use them are limited.  

Item Keyboard BP Mode(s) Comment 

Undo Ctrl  + Z All Reverses your most recent action 
within the Batch Pilot Window.   

The action might involve a project 
or a form…a script or a control. Or 
it might reverse a step you’ve taken 
in an environment such as the Rule 
Manager Window. 

Cut Ctrl  + X All Deletes a highlighted setting or text 
– even a control – and places it on 
the Batch Pilot clipboard.   

Copy Ctrl  + C All Copies a setting, text or control and 
places it on the Batch Pilot 
clipboard. 

Paste Ctrl  + V All Pastes a setting, text or control from 
the clipboard into the target element 
of the Batch Pilot Window. 
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View Menu 
The contents of the View menu change significantly according to Batch Pilot’s mode. 

Item Keyboard BP Mode(s) Comment 

Toolbars n/a All except Task 
Operations (below) 

Lists the toolbars you can use for 
Task Development, Project 
Specifications, and Form Design 
and Testing. 

Main is the window’s standard 
toolbar and is available for all 
procedures  

Form contains icons you’ll use 
to set up and test Datacap 
forms. 

Layout deals with the placement 
and properties of individual 
controls within a form. 

Script provides you with a 
number of scripting tools. 

(Page 26 describes the toolbars of 
the Batch Pilot Window.) 

Toolbar Ctrl + Alt + M Task Operations Displays the Batch Pilot 
Window’s standard toolbar for 
Task Operations (Page 33).   

Status Bar n/a All A toggle switch to display or hide 
the Batch Pilot Window’s Status 
Bar. 
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View Menu 

         View Menu (continued) 

Item Keyboard BP Mode(s) Comment 

Setup Tree 
(Task 
Project 
Setup mode) 

 

Batch Tree 
(Task 
Operations 
mode) 

Ctrl + Alt + S Task Project Setup 

Task Operations 

Opens and closes the Batch Pilot 
Window’s Batch View area 
(illustrated on Page 8). 

1.) When you are setting up a Task 
Project (Chapter 4), the items in this 
area connect the project to its setup 
and runtime forms. 

2.) When a task such as Verification 
or FixUp is running, this area lists the 
documents and pages in the current 
batch. 

Alert! The Batch View area is not 
available when you define a task 
within Taskmaster, assign it to a job, 
and then access the Batch Pilot 
Window to link the task to its Batch 
Pilot Task Project Specifications 
(Chapter 4). 

Thumbnail n/a Task Operations Shows or hides thumbnails of the 
images in a batch.    

Image View Ctrl + Alt + I Form Development 
and Testing 

Project Setup and 
Testing 

Opens and closes the Batch Pilot 
Window’s Image View area 
(illustrated on Page 8.) 

This area is a development tool 
you’ll use to determine if a window 
or dialog can successfully display the 
image of a scanned page, of a 
fingerprint, or of any other 
acceptable Image file format. 

Log Viewer n/a Task Setup, Task 
Operations 

Shows or hides Batch Pilot’s Log 
Viewer dialog during Task 
Definition, and Task Operations if 
the task’s dialog is not hidden. 
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 View Menu (continued)  

Item Keyboard BP Mode(s) Comment 

AutoSave n/a Task Operations Remembers the Batch Pilot 
Window’s current size and scale. 

Super 
Snippet 

Ctrl + S Verify Task 
Operations 

Displays the magnified image of a 
single field of a source page after the 
Data Entry operator has selected the 
field. 

Keep SS 
Visible 

n/a Verify Task 
Operations 

Automatically displays a Super 
Snippet next to any field the Data 
Entry operator selects. 
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Form Menu 

Form Menu 
The items in this menu help with the development and testing of Datacap forms (Chapter 
3) – and with the setup of a Task Project (Chapter 4). 

Remember.  Although most Datacap forms are tightly linked to a task’s setup or runtime 
procedures, you can use Batch Pilot to assemble forms that do not have task affiliations. 
The Rule Manager Window is one example: a full explanation of this very important 
window is in Chapter 3 of the Rule Manager Reference. 

9 Most items in this menu are duplicated by toolbar icons (Page 26). Be sure to use the 
View menu’s Toobars selection to place these toolbars in convenient locations within the 
Batch Pilot Window. 

Item Keyboard BP Mode(s) Comment 

Design n/a Design, Test  A toggle switch that places a form 
in Design mode (checked) or Test 
mode (unchecked). 

Design mode allows you to 
add, remove, and modify 
controls; write, edit and test 
scripts; “bind” the form to 
other forms and “external” 
objects; and set up one or more 
hot keys for a form’s user. 

Test mode shows you what the 
form looks like when it is 
active, and gives you a chance 
to assess the behavior of 
individual controls.  

Toolbox n/a Design  Displays or hides the Batch Pilot 
Development Toolbox.  

You’ll use this toolbox to select 
controls and place them on a 
form. 

View Code n/a Design  Displays the code for all controls  
- including the UserForm 
control. 
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 Form Menu continued  

Item Keyboard BP Mode(s) Comment 

Run Script n/a Test  Tests a script you’ve selected by 
using the View Code option, or 
by double-clicking on a control 
and scrolling to the applicable 
event. 

Important! Although you’re 
probably running the script for a 
single control other than for the 
UserForm control, selecting this 
option places all controls in Test 
mode. 

De-selecting this toggle switch 
terminates the test. 

Pause Script n/a Test  Halts a script you’re testing. 

Clicking again resumes the test.  

Selecting this option does not 
return the form and its controls to 
Design mode.  

Stop Script  n/a Test  Terminates the test of a script. 

Bind 
Control 

Ctrl + B Design  Binds the current control to a 
control you designate. 

Find 
Unbound 

n/a Design  Unbinds a bound control. 

External 
Objects 

n/a Design  Accesses the Objects dialog, and 
a series of Microsoft and Datacap 
objects you can use to increase 
the power of your form, or 
expand its scope. 

Hot Keys n/a Design  Retrieves the Hot Keys dialog. 

You can use this dialog to define 
hot keys to assist with your 
scripting (Chapter 3). 
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Layout Menu 
These Design items help arrange controls within a form. 

Item Keyboard BP Mode(s) Comment 

Snap to Grid n/a Form Development 
and Task Project 
Setup 

Sets up a grid within the 
UserForm control, and snaps 
other controls to specific X and Y 
coordinates within the grid.   

Bring to 
Front 

n/a Form Development 
and Task Project 
Setup 

In the case of overlapping 
controls, brings the selected 
control to the forefront. 

Send to 
Back 

n/a Form Development 
and Task Project 
Setup 

In the case of two overlapping 
controls, places the selected 
control behind the other control. 

Group n/a Form Development 
and Task Project 
Setup 

Groups two or more controls so 
you can move them as a unit 
around the form. 

This option is a design 
convenience; it does not in any 
way unite or otherwise affect the 
properties, actions or events of 
the individual controls. 

Ungroup n/a Form Development 
and Task Project 
Setup 

Disconnects the controls which 
form a group.   

 
 

Continued on the next page → 
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          Layout Menu (continued) 

Item Keyboard BP Mode(s) Comment 

Align n/a Form Development 
and Task Project 
Setup 

Options you can use to “align” 
two or more selected controls 
within the form.  

Important! The first control you 
select serves as the basis for 
positioning. 

Left lines up the controls 
vertically, along their left 
edges. 

Right lines up the controls 
vertically, along their right 
edges. 

Top aligns the controls 
horizontally, along their top 
edges. 

Bottom aligns the controls 
horizontally, along their 
bottom edges. 

To Grid locks the controls into 
the User Form’s grid. 

Make Same 
Size 

n/a Form Development 
and Task Project 
Setup 

Re-sizes two or more selected 
controls. 

Important! The first control you 
select provides the standard size. 

Both re-configures the height and 
width of selected controls to be 
sure they match the 
measurements of the standard 
control. 

Horizontal re-configures the 
width of the selected controls to 
match the width of the standard 
control. 

Vertical re-configures the height 
of the selected controls to match 
the height of the standard control. 
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Layout Menu 

         Layout Menu (continued) 

Item Keyboard BP Mode(s) Comment 

Align 
Centers 

n/a Form Development 
and Task Project 
Setup 

Aligns two or more selected 
controls according to their center 
points. 

Tab Order  Form Development 
and Task Project 
Setup 

Sets the order in which a 
keyboard’s Tab key moves from 
one control to the next 

Properties  Form Development 
and Task Project 
Setup 

Opens and closes the Properties 
dialog of the control you select 
(Chapter 3). 
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Script Menu 
Items in this menu assist in the formatting of a script. 

They are available when you are developing a Datacap form (.dcf), or setting up a Task 
Project (.bpp) – after you select View Code from the Form menu. 

Item Keyboard BP Mode(s) Comment 

Show 
Member 

n/a Form Development 
and Task Project 
Setup 

Lists pre-defined “member” 
functions you can add to a script. 

Show 
Tooltips 

n/a Form Development 
and Task Project 
Setup 

A toggle switch that displays or 
hides tooltips for the member 
functions (above). 

Toggle 
Breakpoint 

n/a Form Development 
and Task Project 
Setup 

Inserts or removes a breakpoint at 
the script’s current location. 

Indents n/a Form Development 
and Task Project 
Setup 

In - indents subsequent lines of 
script 

Out - returns the script to its 
standard left-edge margin.  

Comments n/a Form Development 
and Task Project 
Setup 

Comment inserts a “ ’ ” to begin 
the text of a comment. 

Uncomment returns the text to 
script format.  

Bookmarks n/a Form Development 
and Task Project 
Setup 

These options are only available 
when Batch Pilot is in Scripting 
mode.  

Toggle adds a bookmark to the 
script, or removes it. 

Clear removes all bookmarks. 

Go to Next moves your cursor 
to the next bookmark. 

Go to Previous moves your 
cursor to the previous 
bookmark. 
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Script Menu 

 Script Menu (continued)  

Item Keyboard BP Mode(s) Comment 

Update 
Script… 

n/a Form Development 
and Task Project 
Setup 

After a proper warning, replaces 
existing scripts for all controls on 
the form, with new scripts.  

Export n/a Form Development 
and Task Project 
Setup 

Serves as a Save as…procedure 
for new form development. 

Import n/a Form Development Allows you to import code when 
you are setting up a new form. 
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Navigate Menu 
Options in this menu help the operator of a Verify or FixUp task move from page to page 
or document to document within the batch, or from field to field within a page – even 
from batch to batch. 

9 Important! This menu only appears when a task is running. 

Item Keyboard BP Mode(s) Comment 

Next 
Problem 

Ctrl + N Task Operations Moves a task such as Verification 
to the next problem page in the 
batch. 

Previous 
Problem 

Ctrl + P Task Operations Moves the task to the previous 
problem page. 

Next Ctrl + Shift + 
N 

Task Operations Moves the task forward, to the 
next page in the batch. 

Previous Ctrl + Shift + 
P 

Task Operations Moves the task backward, to the 
previous page in the batch. 

 
9 You can find out more about Verify tasks in Chapter 10 of the Guide to Taskmaster 

Rules, and more about FixUp tasks in Chapter 11. 

Help Menu 
The Help Topics item accesses Batch Pilot Help. 
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Toolbars of the Batch Pilot Window 
When you are developing a Datacap form (Chapter 3) or assembling the elements of a 
Task Project (Chapter 4), the Toolbars item of the Batch Pilot Window’s View menu 
lists four toolbars: Main, Form, Layout and Script. However, the availability and make 
up of a toolbar may change, depending on the window’s role at a particular moment. 

When a Batch Pilot task is running, the window presents the icons of a single Operations 
toolbar. The makeup of this toolbar also changes, in response to the requirements of the 
task. 

Similarly, if you are defining a new task or reviewing the Project Specifications of an 
existing task, the Batch Pilot Window features one Task Setup toolbar with just a few 
icons. 

Finally, there are Batch Pilot products that don’t use toolbars. Often, these are Datacap 
forms with User Interfaces that hide the Batch Pilot Window when they are active. (The 
Rule Manager Window is one example.)    

The section below reviews the Form Development and Task Project toolbars of the Batch 
Pilot Window.  The section on Page 33 describes the window’s Task Setup toolbar; Page 
33 explores toolbars of the window’s Operations mode. 

Form Development and Task Project Toolbars 
When you use the Batch Pilot Window to develop and test a Datacap form (Chapter 3) – 
or set up a Task Project (Chapter 4) - the Toolbars option of the View menu has four 
items. Clicking on an item places the toolbar in the window and a check next to the title; 
clicking again removes the check and the toolbar. 

 
Toolbar options – Form Development 

These are drag-and-drop toolbars: you can re-position a toolbar within a bar, or move it 
from the bar at the top to the bar at the bottom. 

9 Keep in mind the distinction between a Datacap form (.dcf), a Task Project (.bpp) that 
includes the form, and a task that uses the form as a setup or runtime dialog.  Don’t 
hesitate to learn more about these fundamental differences by experimenting freely with 
the forms, projects and Task Definitions of the 1040EZ training application. 
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Main Toolbar    
This toolbar helps you manage contributions of the Batch Pilot Window to Form 
Development and Task Project Setup: 

 

Main toolbar 

Main Toolbar 

From left to right, the icons include: 

New Form. Places a blank Datacap form in the window’s Data Area, along with the 
Development Toolbox.  Menu Equivalent: File/New Form. Keyboard: Ctrl + N. 

Open Form. Retrieves an existing Datacap form and displays it in the Batch Pilot 
Window, in Design mode. Menu Equivalent: File/Open Form. Keyboard: Ctrl + O. 

Save Form. Saves changes to the Datacap form you’re working with. Menu 
Equivalent: File/Save Form. Keyboard: Ctrl + S.  

Print. Prints a Datacap form’s scripts and logs, or a graphic representation of the 
Data Area’s contents.  Menu Equivalent: File/Print. Keyboard: Ctrl + P. 

Open Project. Accesses the Open Project dialog so you can open an existing Task 
Project file (.bpp). Menu Equivalent: File/Open Project. Keyboard: Ctrl + Alt + O. 

Cut. Deletes a setting or text you highlight – even a control! – and places it on the 
Batch Pilot clipboard. Menu Equivalent: File/Cut. Keyboard: Ctrl + X. 

Copy. Copies a form’s setting, text or control and places it on the Batch Pilot 
clipboard. Menu Equivalent: File/Copy. Keyboard: Ctrl + C. 

Paste. Pastes the contents of the Batch Pilot clipboard into the target element of the 
form you’re working with. Menu Equivalent: File/Paste. Keyboard: Ctrl + V. 

Image View. Opens and closes the window’s Image View area.  Menu Equivalent: 
View/Image View. Keyboard: Ctrl + Alt + I. 

Help. Accesses Batch Pilot Help. 
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Form Toolbar 
Icons of this toolbar move you in and out of Form Development’s Design, Script and Test 
procedures: 
 

 

Un-tethered 
Form toolbar 

From left to right, the icons include: 

Design/Test. Toggles a Datacap form in and out of the form’s Design and Test 
modes. Important! When this icon is depressed (Design), the Controls Toolbox is 
available. Furthermore, you can only use Form Development’s Layout toolbar if you 
first depress this icon. Menu Equivalent: Form/Design. 

Edit Script. Converts the Batch Pilot Window to its Script format; opens the form’s 
complete script; and places your cursor in the opening [General] section. You can 
work within this section, or move to scripts for other controls. Important! When you 
use this icon, icons of the Layout toolbar are visible but not available. Menu 
Equivalent: Form/View Code.  

Run Script. Tests a script you’ve previous selected. Alert! Clicking on this icon 
places the entire form in Test mode – even if you are testing the script for a single 
control. Menu Equivalent: Form/Run Script.  

Pause Script. Interrupts the test of a script. Clicking on the icon again resumes the 
test.  Menu Equivalent: Form/Pause Script. 

Stop Script. Terminates a script’s test. Menu Equivalent: Form/Stop Script. 

Test Form. Tests the overall form. This icon is only available if Batch Pilot is in 
Design mode.  

Alert! This toolbar is not available if you are working with a new Task Project, but have 
not yet assigned forms to the project. 
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Layout Toolbar 
These icons help you set up a form’s structure; organize and align its controls; and 
specify a control’s background and foreground colors. 

9 Because a new project opens with a standard “User Form”, a limited set of icons in this 
toolbar is a available for Task Project Setup. 

 

       Layout  
        toolbar 

Sample Datacap Form with controls 

From left to right, the icons include: 

Bring to Front. In the case of overlapping controls, brings the control you select to 
the template’s forefront. Menu Equivalent: Layout/Bring to Front.  

Send to Back. In the case of two overlapping controls, places the selected control 
behind the other control. Menu Equivalent: Layout/Send to Back. 

Group. Groups two or more controls so you can move them around the form as a 
unit. Menu Equivalent: Layout/Group. 

Ungroup. Disconnects the controls which comprise a group.  Menu Equivalent: 
Layout/Ungroup. 

Align Edges.  Options you can use to align the edges of selected controls within the 
form. The icon’s Spin button lists the options: Lefts, Centers, Rights; Tops, Middles, 
Bottoms; to Grid. Two important considerations:  1.) Centers aligns controls 
according to their horizontal center points. 2.) With the exception of the to Grid 
option, the first control you select serves as the basis for positioning. Menu 
Equivalents: Layout/Align, Layout/Align Centers. 

Make Same Size. Re-sizes two or more selected controls. The icon’s Spin button 
lists three options: Width, Height, Both. The first control you select provides the 
standard size. Menu Equivalent: Layout/Make Same Size. 

Align Centers. Aligns the horizontal or vertical centers of controls you select. The 
icon’s Spin button displays the two options; if you click on the icon without making a 
selection, Batch Pilot uses the horizontal center points to align the controls.  Menu 
Equivalent: Layout/Align Centers.  
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Properties. Opens and closes the Properties dialog box for the control you select. 
Menu Equivalent: Layout/Properties.  

Background Color. Assigns a background color to the control you select. The Spin 
button opens the Background Colors Palette; you can use the palette to choose an 
existing color or mix a custom color. Important! If you click directly on the icon, 
Batch Pilot applies the color you have selected most recently from the palette. 

Foreground Color. Assigns a color to a control’s “foreground” element – the 
characters of a title or Text  property, for example, or the graphics on an action 
control. The icon’s Spin button opens the Foreground Colors Palette; you can use 
the palette to choose an existing color or mix a custom color. Important! If you click 
directly on the icon, Batch Pilot applies the color you have selected most recently 
from the palette. 

Zoom. Alters the magnification of the Datacap form and all its controls within the 
Batch Pilot Window but does not change the window’s magnification within your 
screen.  
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Script Toolbar 
Icons in this toolbar assist with your scripting activities. Alert! Selecting Script from the 
View menu’s Toolbars items adds the toolbar to the Batch Pilot Window. However, the 
icons are available only if the window is in Script mode. To work in this mode, you can: 

• Double-click on a control; or 

• Press the Form toolbar’s Design icon (Page 28); or  

• Select View Code from the Form menu. 

9 The full range of tools is available when you select a few lines of code. 
 

 

Script toolbar

From left to right, icons of the Script toolbar include: 

Options. Accesses the Script Editor Options dialog, and numerous settings involved 
in maximizing the layout and appearance of your script as an essential Form 
Development document.  

Members.   Lists standard functions that you can use to when scripting a control. 
Menu Equivalent: Script/Show Member. 

Tooltip Information. A toggle switch that displays or hides the value of a specific 
control’s Tooltip property. Menu Equivalent: Script/Show Tooltips. 

Toggle Breakpoints. A toggle switch that displays or hides breakpoints in the code.   
Menu Equivalent:  

Indents. A formatting device with two options. Indent decreases the left-side margin 
of highlighted lines of script, and any subsequent lines. Outdent returns highlighted 
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script (and subsequent lines) to the default left margin. Menu Equivalent: 
Script/Indents. 

Comments. A programming device with two options. Comment inserts a “ ‘ “ to 
mark the beginning of one or more commented lines, and alters the font’s shade. 
Uncomment returns previously “commented” text to active code. Menu Equivalent: 
Script/Comments. 

Bookmark. Manages the insertion and use of bookmarks within the script. The 
icon’s Spin button has four options. Toggle inserts or removes a unique bookmark in 
the script’s current location. Go to Next moves your cursor to the next bookmark. Go 
to Previous moves your cursor to the previous bookmark. Clear deletes all 
bookmarks. Menu Equivalent: Script/Bookmark. 

Properties. Opens and closes the Properties dialog box for the control you select. 
Menu Equivalent: Layout/Properties.  

Find. Opens the Script mode’s Find dialog. This very handy option locates words 
and phrases almost instantly.  

Replace. Opens the Script mode’s Replace dialog – a helpful editing tool that 
replaces words and phrases inside a section, or throughout your Datacap form’s file. 

Repeat. Automatically repeats your most recent procedure involving an icon of the 
Scripts toolbar. For example, if the Replace icon helps you substitute one example 
of Stats with Stats_New, clicking on this icon finds the next example and 
repeats the step. 

9 Right-clicking in the Scripting dialog provides comparable and additional programming 
aids that are explained in Chapter 3. 
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Task Setup Toolbar 
Taskmaster’s Task Definition process links a task to its Task Project. The Task Project’s 
setup form, in turn, provides the Taskmaster administrator who is defining the task with a 
Task Setup dialog. Here, for example, is the 1040EZ Export task’s Setup dialog as it 
appears in the Batch Pilot Window during the Task Definition process. 

 

 

     Task Setup 
           toolbar 

1040EZ Export Task Setup dialog 

The window’s Task Setup toolbar appears automatically when you are setting up a task, 
and has these icons (from left to right). 

Task Settings. Accesses the Task Settings dialog. The tabs of this dialog have 
certain required specifications: for details, see Chapter 4 or Batch Pilot Help. Menu 
Equivalent:File/Task Settings. 

Print.  Prints a limited version of the current Task Settings dialog. Menu Equivalent: 
Menu Equivalent: File/Print. 

Cut. Deletes text values from certain fields and adds them to the Batch Pilot 
clipboard.  Menu Equivalent: Edit/Cut. 

Copy: Copies text values in certain fields and adds them to the Batch Pilot clipboard.  
Menu Equivalent: Edit/Copy. 

Confidential and Proprietary Information of Datacap Inc. Page 2–33 
Copyright © 2006 Datacap Inc. 



Task Setup Toolbar 

Paste. Copies text values in the Batch Pilot clipboard into a data entry field of the dialog.  
Menu Equivalent: Edit/Paste. 

Quit Setup. After a proper warning, closes the Batch Pilot Window and terminates the 
Task Setup process. Menu Equivalent: File/Quit. 

Help. Accesses Batch Pilot Help. Menu Equivalent: Help/ Help Topics. 

Page 2–34 Confidential and Proprietary Information of Datacap Inc. 
 Copyright © 2006 Datacap Inc. 



Chapter 2: The Batch Pilot Window 

Operations Toolbar 
 During Task Operations, the Batch Pilot Window toolbar has these icons: 

  
Verify Task Operations 

9 The illustration shows the runtime dialog of a task that requires significant operator 
participation – in this case, a Verify task. FixUp tasks are also operator-intensive. 

Most tasks, however, operate in the processing background: although the Batch Pilot 
Window and the Operations toolbar are briefly visible, the operator usually does not 
have access to either. 

From left to right, the icons include: 

Print: accesses the driver that links you to your printer.  

Cut: cuts selected text and adds it to your clipboard. 

Copy: copies selected text and adds it to the clipboard.  

Paste: pastes the clipboard’s text to a text field of an Operations dialog or panel. 

Batch Tree: a toggle switch that displays or hides the content of the current batch. 

Thumbnails: a toggle switch to display or hide Image Thumbnails for the batch. 

Image View: a toggle switch to display or hide the window’s Images area. 

Previous Problem: moves a task’s attention to the previous “problem” field or page. 
This icon is only available when a Verification or FixUp task is running. 

Next Problem: moves a task’s attention to the next “problem” field or page. This 
icon is only available when a Verification or FixUp task is running. 

Quit Task: terminates the task’s operations after a proper warning, closes the Batch 
Pilot Window and returns you to Taskmaster.   

Help: accesses Batch Pilot Help. 
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Scripting Aids of the Batch Pilot Window 
The sequence below creates a new Datacap form (.dcf ) with just four controls: a label, a 
text field, a button, and the UserForm itself. 

Step Action 

1. Select New Form from the Batch Pilot Window’s File menu: an untitled 
Datacap form will appear in the window’s Data Area. 

 

Development 
Toolbox 

2. Click on the Toolbox icon. 

 

3. Use the drag-and-drop tools in the Toolbox to place three controls on the new 
form. 
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Scripting Aids of the Batch Pilot Window (continued)  

Step Action 

4. Save the form in a convenient location. 
 

 
NewForm.dcf 

9 Even this very simple form provides a chance to explore and evaluate the following 
Batch Pilot Window scripting aids: 

Control Properties. When the window is in Design mode, you can access the 
control’s Properties dialog if you: 

♦ Right-click on the control and select Properties from the options; or 

♦ Select the Properties item of the Layout menu; or 

♦ Click on the Properties Window icon of the Layout toolbar.  

Form scripts -  special tools. When a form is in Scripting mode (illustrated on the 
next page), right-clicking in the window’s Data Area produces a list of scripting aids. 
The second section has four special items: 

♦ List Objects identifies all controls in the form; the FormDriver object; 
Datacap’s Pilot, ImageCtrl, and DCO objects. The list also identifies those 
objects of the Windows Script Host that you have used in the script. Alert! 
Clicking once on an object inserts it into the script. 

♦ List Properties/Methods is a comprehensive lists the properties and 
methods that are part of the form’s script.  

♦ List Functions lists VBScript’s built-in and scripting runtime objects. 

♦ Quick Info describes the attributes of a nearby object or function. 

The window’s Code Content icons list code for (from left): a single event of the 
current object; all of the object’s events; all code for the form. 
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    Click here 

                Code 
           Content  

P
 

Scripting 
aids 
 
Scripting Environment Assistance 

Alert! Copying a control’s script or a portion of the script and pasting it into the script of 
another control requires special steps. These steps are outlined in Chapter 3 (Forms).   
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